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Permanently delete files 
If you want to permanently delete files without moving them to Recycle bin, hold down the Shift key while 
pressing delete. If you don't want the recycle bin altogether, right-click the Recycle Bin and click on Properties. 
On the Global Tab, select Do not move files to the Recycle Bin. If you enable configure drivers independently, 
you can set this up for the drivers you want. 

Windows System Configuration 
A very useful tool included with Windows is the System Configuration Utility. Select Start > Run and type 
'msconfig' in the Open box to launch the application. The system Configuration utility makes fiddling with 
programs to launch at Startup or editing autoexec.bat, config.sys etc. a lot easier. To system Configuration 
Utility also allows you to crease a backup of your system files. It would be a good idea to use this before you 
begin making changed. 

Preview Images 
You can easily preview your Image files by enabling "Web View" from the toolbar or from the Windows Explorer 
menu, select View > As Web page. A better way to preview images is as thumbnails instead of icons. To enable 
this view in Windows Explorer, right-click the folder you want to preview and click on Properties. Check the box 
against Enable thumbnail view and click OK to exit the dialog box. Now, form the View menu, select 
Thumbnails. 

Optimizing the Swap File 
Windows uses a portion of the hard disk as RAM, constantly swapping data between RAM and hard disk as 
required. The speed of your hard disk is in the order of 1000 times slower than that of your main memory. 
Inefficient use of the swap file could considerable slow down your system to a very great extent. One of the 
best ways to speed up the swap file usage is to create a permanent swap file. In a permanent swap file, the file 
used for swapping information has a fixed size and location on your hard disk. When a temporary swap file is 
used, the location and size of the file is determined by application being used and is not predictable. Also, since 
a temporary swap file is constantly written to and is not fixed in size, it would be highly fragmented across the 
partition that holds it. A better option is to create the swap file on a dedicated partition on your hard disk. By 
doing this, the swap file will never be fragmented since that partition is only being utilized by the swap file 
itself. You can configure the swap file size and location from Control Panel > System > 
Performance > Virtual Memory. The size of the swap file should be around 2.5 times the amount of 
RAM on the system.  

Dummy entries in Add/Remove Programs list 
Sometimes, even after program are uninstalled, or due to the files being deleted instead of a uninstalled, the 
entry in the Add/Remove Programs list does not get deleted. To remove it form the list: 1. Start the Registry 
Editor. 2. Open HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows \CurrentVersion\Uninstall. 3. Delete the 
program entry here. You can also use TweakUI to do this. 

Restart only Windows 
When restarting Windows, you don't always need to go to thought the BIOS initialization and POST. Instead of 
simple clicking on Restart form the Shut Down Windows dialog box, help down the Shift key as you click on OK. 
This will restart only Windows. This is particularly useful when you change some registry entries or a few 
system settings. 

Improve Removable Disk Drive Performance 
Windows gives you the option to use write-behind caching to improve the performance of removable disk 



drivers. 

• Open control Panel > System > Performance and click on File System.  
• Check the Enable write-behind caching on all removable disk drives check box under the removable 

Disk tab and click OK 

Note: If this result in a problem with disk operations, uncheck the Enable write-behind caching on all removable 
disk drives check box. 

MS Office memory hoggers 
A typical installation of MS Office installs Find Fast, an indexing utility that loads at startup. This hogs system 
resources by regularly indexing the entire hard disk(s). You can improve performance of your computer by 
removing Find Fast form your Startup folder. To reclaim the space used by the Find Fast index, open Control 
Panel > Find Fast, select your hard drives(s) and form the Index menu, click on Delete Index. When you've 
deleted your Index, click on Close and Stop form the Index menu. Another item installed in the Startup folder is 
named Microsoft Office. This does nothing apart from loading all MS Office libraries at startup to speed up 
launching of any Office applications. Since this is not necessary, you can delete this shortcut, too. 

Stop Automatic Dialing 
Many Internet applications or software are often set to automatically dialup and connect. To setup automatic 
dialing, open Control Panel > Internet Options. Under the Connections tab, enable Never dial a connection. 

Automatic maintenance 
The Windows Maintenance Wizard can automate a lot of routine system maintenance tasks. To open this 
wizard, choose Start > Programs > Accessories > System Tools > Maintenance Wizard. It sets up the Task 
Scheduler to regularly run Scandisk, Disk Defragmenter and Disk Cleanup. 

Clean Desktop 
To hide all the icons on your Desktop, open the Registry Editor and navigate to 
HKEY_CURRENT_USER\Software\Microsoft \Current Version\Policies\Explorer. Add a DWORD value and name it 
NoDesktop. Change it's value to 1. Close the Registry Editor and restart Windows. 

ToolTips 
To disable ToolTips in Windows, open the Registry Editor and navigate to HKEY_USERS\.DEFAULT\Control 
Panel\Desktop. Double-click UserPreferencemask and change its value to 3E 00 00 00. Chose the Registry 
Editor and restart Windows. 

Speed up your modem  
Even if your modem if apparently working well, the baud rate of your COM Port might not allow you to reach 
top-speed. To improve your port's speed:  

• Click Start >Settings > Control Panel > System. 
• Click the Device Manager tab, and click on the "+" sign next to Ports (COM & LPT).  
• Select the port your modem uses, click Properties, then click the Port settings tab and set the Bits per 

second to 115200 bps. That way you won't have a sort of filter on the Port. 

Associations in a jiffy 
To associate files of a certain type with a different program, hold down the Shift key while right-clicking on a 
file of that type and click on Open With... from the context menu. Select the program you want to open files of 
this type with and enable Always use this program to open this type of file. Henceforth, the file will always open 
with this program when double-clicked. 

A clean Registry 
As time passes the computer's registry accumulates a lot of corrupted, unused, and unnecessary register keys, 
especially if keys are not removed when you uninstall a program. As a result, you might experience problems 
and your machine might function slower than expected. The latest version of Microsoft's RegClean could delete 
a lot of such registry junk. You can download this from zdnet Just search for RegClean and it will let you 



download it. Best of all, it is free !! 

Assigning passwords to folders in win 98 and 2000 
Right-click on empty space in the folder which you want to protect and 
select CUSTOMIZE THIS FOLDER, then choose CREATE HTML DOCUMENT FOR THIS 
FOLDER. Once the document is opened in Notepad, scroll down until you see 
<script language>="JavaScript"> Insert a blank line after this string. 
Then insert the following text. 

var pass = prompt("Enter the password") 
if(pass != "YOURPASSWORD") 
{window.location="C:"} 
Hit the Enter key on your keyboard 

Put a password in the place of YOURPASSWORD but leave the quotes. Save the 
document, exit Notepad, 
refresh the folder (or hit F5), enter your new password, and the next time 
you try to enter that folder, 
you'll be prompted for your password. If you enter a wrong password you'll 
end up in C: drive! 

This works on Windows 98 and 2000. 
 

 

Trace the route 
A great utility included with Windows is a program called Trace Route. Open a DOS window and type tracert <location 
name>. The location name can be any IP address or Internet domain like tracert .The program will then trace the route 
from your Internet service provider to that locating, and show you every server along the way. This could be useful for 
when you can't connect to a site it will show you if some server is down along the way. 

Select your Monitor  
Windows might not always detect your Monitor accurately. This affects display and refresh rates. To select your monitor 
manually:  

• Right-click on the Desktop.  
• Choose Properties from the context menu. On the Settings tab press Advanced button. Select the Monitor tab. If 

your monitor is not listed (correctly) here, click on Change.  
• Select your Monitor form the list, or if you have a driver disk for your monitor, select have Disk.  
• Click Apply, and follow any other instructions on screen. 

Redialing 
Dial-Up Networking provides for automatic redial.  

• Open Dial-Up networking.  
• Select your connection.  
• From the menu select Connections > Settings.  
• Enable, Redial, select the number of times to redial and click OK. 

A clean Run! 
To remove unwanted items form the Run menu:  

• Start the Registry Editor.  
• Open HKEY_CURRENT_USER\Software\ Microsoft\Windows\CurrentVersion\Explorer\RunMRU.  
• Delete the entries that you do not want on Run menu.  



• Close the Registry Editor and Restart Windows. Note: Do not delete the (Default) or MRUList values. 

Bitmap as icons 
You can preview bitmaps (.BMP files) as icons in Explorer instead of the default icon of the application it is associated with. 
Open the Registry Editor and navigate to HKEY_ CLASSES_ROOT\Paint.Picture\DefaultIcon. Double-click the Default string 
and change it's value to '%1' (without quotes). Close the Registry Editor and restart windows. 

Window and menu Animations 
One of the desktop enhancements built into windows is the animation displayed when you minimize and maximize windows 
or when displaying menus. Disabling this makes navigating Windows a lot faster. Open the Desktop Properties dialog by 
right-clicking any blank area of the desktop and clicking on Properties. Disable Animate windows, menus and lists form the 
Effects tab. 

Smooth Screen Fonts 
You may find that the fonts in your Internet Explorer and other windows seem jagged as you increase the font size. To 
make them smooth and thus, beautiful. 

• Right-click anywhere on the free space of the Desktop and click properties 
• Select the Effects tab from the Display Properties  
• In the Visual effects frame, enable Smooth edges of screen fonts  

Change the Refresh rate of your Graphics Adapter 
Refresh rate of your monitor determines how fast the screen if updated. Generally, the higher refresh rate monitor can 
support, the better. Optimum refresh rates can be set manually for a flicker-free display. If Windows hasn't already 
configured it. Right-click on the Desktop, click on Properties and open Settings > Advanced > Adapter. Depending on your 
graphics card and monitor, you will get different choice for the refresh rate. Click on Apply after setting the appropriate 
refresh rate. Click through the warning message to change the refresh rate. If, for some reason the display becomes 
garbled, don't do anything, Windows will restore the original refresh rate. 

Speed-up your connecting time 
To speed-up the time it takes for Dial Up Networking to establish a connection with your ISP:  

• Open Dial-Up Networking.  
• Right-click your connection and choose Properties.  
• On the server types tab, under Advanced Options, make sure that the check-box for Log on to network is 

unchecked.  
• Under Allowed network protocols select only TCP/IP and uncheck NetBEUI & IPX/SPX  

Load Outlook Faster 
If you're tired of waiting the Outlook Express to start up, there's a way to make it faster. Open the RegEdit and navigate to 
the next path:  

HKEY_CURRENT_USER\Identities\[nr of id]\Software\Microsoft\Outlook Express\[vers] 
Then create a new DWORD value called NoSplash, and assign the value 1. Remember to take a backup of the Registry 
before doing this! For more information on how to backup your registry,  
 

Convert WMF Files Into BMP Files in Visual Basic 
Create a new project, add a form, then put a picture box and a command button into it. Add block of code into command 
button click event. 

Private Sub Command1_Click()  
' Load meta picture file 
Picture1.Picture = LoadPicture("C:\test.wmf")  



' Save meta picture to bitmap file 
SavePicture Picture1.Image, "C:\test.bmp"  
End Sub  

Break an RGB color value into its components in Visual Basic Use : 

r = color And &HFF& 
g = (color And &HFF00&) \ &H100& 
b = (color And &HFF0000) \ &H10000 

There are some system colors that have funny values like &H8000000F&. Unfortunately they don't work this way. You can 
use the GetSysColor API function to find these color values. Use And to mask off the leftmost digit. Then use GetSysColor to 
see get the color value.  
Public Declare Function GetSysColor Lib "user32" Alias "GetSysColor" _ 
(ByVal nIndex As Long) As Long 

If color And &H80000000 Then color = GetSysColor(color And &HFFFFFF) 

One final case occurs if you use Point to get the color of a pixel that does not exist. For example, on a form with ScaleMode 
= vbPixels, Point(-100, -100) returns -1 because there is no  
pixel at (-100, -100).  

The following subroutine breaks a color into its components. If the color is -1, the routine leaves r, g, and b unchanged. 
Depending on your application, you may want to set them to default values such as 0 or 255.  

Public Declare Function GetSysColor Lib "user32" Alias "GetSysColor" _ 
(ByVal nIndex As Long) As Long 

' Break a color into its components. 
Private Sub BreakColor(ByVal color As Long, ByRef r As Long, ByRef g As Long, _ 
ByRef b As Long) 
If color = &HFFFFFFFF Then Exit Sub 

If color And &H80000000 Then _ 
color = GetSysColor(color And &HFFFFFF) 

r = color And &HFF& 
g = (color And &HFF00&) \ &H100& 
b = (color And &HFF0000) \ &H10000 
End Sub 

 
How to Hack an EXE File 
Could you edit an executable file when it has been compiled? Yes, you could. But you could only change the String data. 
How? Using the MS-DOS Text Editor. The String data is text, but in the file will appear different. For example, if in the 
application appears  

About NotePad in the compiled file will appear A b o u t N o t e P a d with an space between each word. Before 
modifying the file, make a back-up of it. If you want to modify the file, first you have to open it using the MS-DOS Text 
Editor and open the file as Binary. Then activate the Insert key and search for some text data in the program. But, it isn't as 
easy as said. You have to search it manually, 'coz the words are separated by a space between. Then replace each word for 
anyone you want. Example:  

N o t e P a d to M y P r o g r 
BE CAREFUL: The file must weight the same than the original; if not, it could not work.  
[Even then the file may not work. For example, it might calculate its checksum and notice that you have made changes. 
This is certainly a dangerous technique. So at least make a backup copy of the file before you mess with it. 



Installing Registry Entries 
Here's an easy way to set registry entries when you install a program. First, create the entries manually on your computer. 
Put them in their own subtree if possible. Use the registry editor to export the subtree containing the entries. This will 
creates a .REG file. Include this in the list of files given to the Package and Deployment Wizard. The Wizard will 
automatically offer to run the registry file on the target system during installation and that installs the registry values. 

Learn ASCII Code in Visual Basic immediate window 
Ever want to know what the chr number is for a character? Open the immediate window by pressing (CTRL+G) and type 
?Asc("") and press enter. The result will appear right before your very eyes.  

Example: the number for a double quote 
?Asc("""") would come as 34 

Using ADO in Access 2000 
To use a Microsoft Access 2000 database and ADO you have to add the correct references in your Visual Basic project. To 
add the references to your Visual Basic project follow the instruction's below.  

Open a project.  
From the Project menu, click References.  
From the list, select Microsoft ActiveX Data Objects 2.1 Library.  
From the list, select Microsoft ADO Ext. 2.1 for DDL and Security.  
From the list, select Microsoft Jet and Replication Objects 2.1 Library.  
Click OK.  
This should let you now use an Access 2000 database with an ADODC control. However Data form Wizard will still face 
problems! 

Understanding Error Handlers 
When you use On Error GoTo and an error occurs, VB enters exception mode. The line you GoTo is supposed to be the 
beginning of an error handler. If an error occurs within an error handler, the program stops. What you need to do is leave 
the error handler and resume normal execution. Then you can use On Error to establish a new error handler for the next 
error. You do this with the Resume statement. See the help for details. In this case, you can use Resume LineLabel to make 
the program continue execution at a specific line.  

Unfortunately, executing Resume from outside an error handler generates an error. Thus you cannot place the error handler 
in the flow of code the way you have. You need to jump out to the error handler and jump back with Resume.  

Below is a subroutine that demonstrates two error handler.  

Private Sub Command1_Click() 
Dim i As Integer 

On Error GoTo Error1 
i = 1 / 0 ' Divide by zero. 
Error1Resume: 
On Error GoTo Error2 
i = 1000000 ' Too big--overflow. 
Error2Resume: 
MsgBox "Finishing." 
' Do not fall through into the error handlers! 
Exit Sub 

Error1: 
' Resume ends error handler mode. 
MsgBox "First error handler." 
Resume Error1Resume 
Error2: 
' Resume ends error handler mode. 
MsgBox "Second error handler." 



Resume Error2Resume 
End Sub 

Stop your modem from frequently disconnecting 

• On the Desk Top Double click on the icon "My Computer" 
• Double click on Dial Up Networking 
• Right click on the Satyam Online icon (or the dialer that you are using) and select Properties on the menu, click on 

configure 
• Click on the Connection Tab and click on Advanced, in Extra Settings, type ats10=250 
• 1) Cracking Windows XP Login Password: 
• Download the nice and easy Nt/2k/xp password cracker from http://www.astalavista.com/or other way is if u get 

acess to the computer then go to Start>Run and type “control userpasswords2” without Quotes and a new pop up 
windows will open and u will reach to user account properties. Here u can Reset the Administrator and any Users 
password so anytime when u Want to use the Computer start it in safemode pressing F8 at Booting get into the xp 
as u have Administrator password and go to Controlpanel>Useraccounts and create a New Account .Start 
Computer Normally and get into WinXP with ur newely made account and do ur job. (Don’t forget to Delete ur 
newely made account Otherwise u will be in trouble) Delete ur account again starting the computer in Safemode 
as Administrator and Delete ur Account. 

• 2)Disable XP Boot Logo: 
• It is possible to disable the XP splash screen, which will slightly speed up the overall boot process. Be aware that 

removing the splash screen will also cause you not to see any boot-up messages that might come up (chkdsk, 
convert ... ), but if your system runs without any problems then it should not matter. 

• Edit boot.ini. Add " /noguiboot" right after "/fastdetect". Upon restarting, the splash screen will be gone. It can be 
re-enabled by removing the new switch. 

• 3)Turn Off Indexing to Speed Up XP: 
• Windows XP keeps a record of all files on the hard disk so when you do a search on the hard drive it is faster. 

There is a downside to this and because the computer has to index all files, it will slow down normal file 
commands like open, close, etc. If you do not do a whole lot of searches on your hard drive then you may want to 
turn this feature off: 

• Open My Computer.  
• Right-click your hard drive icon and select Properties.  
• At the bottom of the window you'll see "Allow indexing service to index this disk for faster searches," uncheck this 

and click ok.  
• A new window will pop up and select Apply to all folders and subfolders.  
• It will take a minute or two for the changes to take affect but then you should enjoy slightly faster performance. 
• 4)Clean Your Prefetch to Improve Performance: 
• This is a unique technique for WinXP. We know that it is necessary to scrub registry and TEMP files for 

Win9X/ME/2000 periodically. Prefetch is a new and very useful technique in Windows XP. However, after using XP 
some time, the prefetch directory can get full of junk and obsolete links in the Prefetch catalog, which can slow 
down your computer noticeably. 

• Open C(system drive):/windows/prefetch, delete those junk and obsolete files, reboot. It is recommended that you 
do this every month.  

• 5)Performance Increase Through My Computer: 
• Easy enough tweak to usually find out about it on your own, but still, some of us still don't find it right away. So 

here it is: 
• Start > right-click on My Computer and select Properties.  
• Click on the "Advanced" tab.  
• See the "Performance" section? Click "Settings".  
• Disable the following:  
• Fade or slide menus into view  
• Fade or slide ToolTips into view  
• Fade out menu items after clicking  
• Show Shadows under menus  
• Slide open combo boxes  
• Slide taskbar buttons  
• Use a background image for each folder type  



• Use common tasks in folders  
• There, now Windows will still look nice and perform faster. 
• 6)Reduce 10 Second Scandisk Wait Time: 
• Start MS Dos Prompt (Start run CMD), and type: CHKNTFS /T:4 
• where 4 is the amount of wait time. 
• CHKNTFS /? 
• for more info.  
• 7)DMA Mode on IDE Devices: 
• Just like Windows 2000, Windows XP still fails to set the DMA mode correctly for the IDE device designated as the 

slaves on the primary IDE and secondary IDE channels. Most CD-ROMS are capable of supporting DMA mode, but 
the default in XP is still PIO. Setting it to DMA won't make your CD-ROM faster, but it will consume less CPU 
cycles. Here's how: 

• Open the Device Manager. One way to do that is to right-click on "My Computer", select the Hardware tab, and 
select Device Manager.  

• Expand "IDE ATA/ATAPI Controllers" and double-click on "Primary IDE Channel".  
• Under the "Advanced Settings" tab, check the "Device 1" setting. More than likely, your current transfer mode is 

set to PIO.  
• Set it to "DMA if available".  
• Repeat the step for the "Secondary IDE Channel" if you have devices attached to it. Reboot.  
• 8)Load Internet Explorer the Fastest Way Possible: 
• Edit your link to start Internet Explorer to have -nohome after it. For Example: "C:\Program Files\Internet 

Explorer\IEXPLORE.EXE" -nohome  
• This will load internet explorer very fast because it does not load a web page while it is loading. If you want to go 

to your homepage after it is loaded, just click on the home button. 
• 9)Easy Way to Adjust LargeSystemCache: 
• Normally, the tweak I've seen asks you to go into HKLM\System\CurrentControlSet\Control\Session 

Manager\Memory Management and change the value to either O or 1 to the adjustment the LargeSystemCache. 
• However, in Windows XP, all you have to do is: 
• Right-click My Computer.  
• Select Properties.  
• Click Advanced.  
• Choose Performance.  
• Click Advanced again.  
• Select either Programs or System Cache under Memory Usage. 
• Programs = 0 for the registry tweak equivalent 
• System Cache = 1 for the registry tweak equivalent 
• 10)Shutdown XP Faster: 
• Like previous versions of windows, it takes long time to restart or shutdown windows XP when the "Exit Windows" 

sound is enabled. To solve this problem you must disable this useless sound.  
• Click Start button.  
• Go to settings > Control Panel > Sound, Speech and Audio devices > Sounds and Audio Devices > Sounds.  
• Then under program events and windows menu click on "Exit Windows" sub-menu and highlight it. Now from 

sounds you can select, choose "none" and then click Apply and OK.  
• Now you should see some improvements when shutting down your system. 
• 11)Easily Disable Messenger: 
• Go into: C:/Program Files/Messenger. Rename the Messenger folder to "MessengerOFF". 
• This does not slow down Outlook Express or hinder system performance. 
• 12)Turn Off Autoplay for Program CDs: 
• How can you stop Windows XP from launching program CDs? 
• Click Start, click Run, type GPEDIT.MSC to open Group Policy in the Microsoft Management Console.  
• Double-click Computer Configuration, double-click Administrative templates, double-click System, and then click 

Turn off autoplay.  
• The instructions on your screen describe how to configure this setting. Click Properties to display the setting 

dialog.  
• Click Enabled, and choose CD-ROM drives, then click OK, to stop CD autoplay.  
• This setting does not prevent Autoplay for music CDs. 



• 13)Synchronize Your Computer Clock with an Internet Time Server: 
• Does your computer have the right time? If your computer is not part of a domain, you can synchronize your 

computer clock with an Internet time server. To do so: 
• Double–click the time on your task bar.  
• Click the Internet Time tab.  
• Select the time server you want to use and make sure to select the Automatically synchronize with an Internet 

time  
• server check box.  
• 14)Win XP Won’t Completely Shutdown: 
• Go to Control Panel, then go to Power Options.  
• Click on the APM tab, then check the "Enable Advanced Power Management support."  
• Shut down your PC.  
• It should now successfully complete the Shut Down process. 
• 15)Adjust Various Visual Effects: 
• Open up the Control Panel.  
• Go under System and click on the Advanced tab.  
• Click settings under Performance options.  
• You can now change various graphical effects (mainly animations and shadows). 
• 16)Disable Error Reporting: 
• Open Control Panel.  
• Click on Performance and Maintenance.  
• Click on System.  
• Then click on the Advanced tab.  
• Click on the error-reporting button on the bottom of the windows.  
• Select Disable error reporting.  
• Click OK. Click OK.  
• 17)Increase Your Cable Modem or DSL Speed in XP: 
• This tweak is for broad band cable connections on stand alone machines with WinXP professional version - might 

work on Home version also. It may also work with networked machines as well. 
• This tweak assumes that you have let WinXP create a connection on install for your cable modem/NIC combination 

and that your connection has tcp/ip - QoS - file and print sharing - and client for Microsoft networks , only, 
installed. It also assumes that WinXP will detect your NIC and has in-box drivers for it. If it doesn't do not try this.  

• In the "My Network Places" properties (right-click on the desktop icon and choose properties), highlight the 
connection  

• then at the menu bar choose "Advanced" then "Advanced Settings". Uncheck the two boxes in the lower half for 
the  

• bindings for File and Printer sharing and Client for MS networks. Click OK. 
• 18)Stop Jerkey Graphics: 
• If you are connected to a LAN and have problems with jerkey graphics, this might be the solution: 
• Right-click "MyComputer".  
• Select "Manage".  
• Click on "Device Manager".  
• Double-click on your NIC under "Network Adapters".  
• In the new window, select the "Advanced" tab.  
• Select "Connection Type" and manually set the value of your NIC. (Not "Auto Sense" which is default.).  
• You should reboot.  
• 19)Speeding Up Your Old Shit Pentium by 50%: 
• We all know that you really shouldn't try to run Windows XP on anything less that about a Pentium 3 of some sort 

if you are out for speedy operations and amazing reaction times, but for those of us with the good old Pentium 2's 
who want to see just how well we can run XP, we have to tweak as much as we can where-ever we can. A real 
killer to the system's performance is Windows Media Player. Although it may look desirable and fancy with it's 
rounded off edges and 3rd-Dimensional appearance, the truth is, it takes up a large amount of that precious 
processing power. All of these troubles however, lead to one thing in particular with this 'new-look' over-rated 
music and video player...the Visualizations. The look-great I'll admit but like a lot of software these days, it has no 
purpose. If you run the task manager, and click the Performance tab along the top, you'll see that when Windows 
Media Player is running and nothing else is active, it takes up around 50% of the processors power. Once these 



visualizations are turned off, it barely takes up 2-3% of the processors power, which leaves much more room for 
other applications to work efficiently.  

• Here's how to disable the feature: 
• Open Media Player.  
• Make sure the Now Playing tab on the left is selected.  
• Click the View menu along the top.  
• Go down to Now Playing Tools 
• 20) Turn Off System Restore to Save Space: 
• By default, Windows XP keeps a backup of system files in the System Volume Information folder. This can eat up 

valuable space on your hard drive. If you don't want Windows to back up your system files: 
• Open the Control Panel.  
• Double-click on System.  
• Click the System Restore tab.  
• Check "Turn off System Restore on all drives".  
• Hit Apply.  
• You may now delete the System Volume Information folder.  
• 1) Shutdown Button on Desktop  
• Right click on ur Desktop and create new Shortcut and type “C:\WINDOWS\SYSTEM32\Shutdown.exe –s” without 

quotes in the popup box which will appear asking for a path of shortcut . Now when u will double click this 
shortcut it will give u shutdown message and ur computer will shutdown after some seconds. U can customize ur 
shutdown button with same icon which original shutdown have Just go to the properties of ur shortcut and click 
change icon tab select any icon u like and click apply. 

• Similarly u can also put restart button on ur desktop just replace –s in above line by –r 
• If u don’t want shutdown button on ur desktop u can the go to start >run and type 
• Shutdown –s or –r they will do the same job. If someone tries to shutdown u remotely on the net then u can stop 

shutdown process but typing shutdown –a in Run. 
• Shutdown –s = Shutdown & restart 
• Shutdown –r = Restart 
• Shutdown –a = To abort shutdown 
• 2) Cracking windows xp admin and user passwords.  

I hope u guys liked tip given for resetting passwords in first part. If u have guest or limited user account on PC 
than that control userpasswords2 tip does not help u much. Windows will still ask u admin password for resetting 
users passwords . 

• Ok go and Download a tool called CIA COMMANDER this is just what we want. This tool will create a copy 
protected bootable floppy which will allow u to boot any computer and also help u to get into any NTFS partition 
.First select floppy as first bootable device from BIOS. CIA shows u every thing to u in GUI. 

• After booting CIA will allow u to reset any user password even administrator’s password. It also includes a file 
manager, registry editor and a text/hex editor. Present version of CIA does not support FAT partitions but sooner 
its new version will even support FAT partition based system. 

• I have read on some tutorials about a tool called NTFS Pro which looks almost like CIA . 
• 3) Correcting System Hang at Startup 
• If your system hangs about 2 or 3 minutes at startup, where you can't access the Start 
• button or theTaskbar, it may be due to one specific service (Background Intelligent  
• Transfer) running in the background. Microsoft put out a patch for this but it didn't  
• work for me. Here's what you do  
• Click on Start/Run, type 'msconfig', then click 'OK'.  
• Go to the 'Services' tab, find the 'Background Intelligent Transfer' service.  
• Disable it, apply the changes & reboot. 
• 4) Editing explorer in windows xp 
• Editing explore in windows xp is very easy with available tools its not as difficult like old dos based tedious method 

here u need just one tool called RESOURCE HACKER 
• It is a resource viewer it will show u Resources in any 32bit Windows 95/98/ME/NT/2000 executable files 

(including exe’s, dll’s, ocx’s and cpl’s) . ok go in to ur windows directory and find explorer.exe and make its two 
copies name them 

• As explorer_1 and explorer_2 .exe respectively and keep them in windows folder only. We will edit explorer_1 and 
will keep explorer_2 as backup copy if anything goes wrong. Open explorer_1.exe in resource hacker and go to 
String table and edit whatever u want to even u can change start button by ur name or anything else 



• After editing even a single word do not forget to click the COMPILE button. Change icon or u can change animated 
message such as when u install a new programs so when u go to all programs a animated message comes “New 
Program Installed” u can change it by ur sentence etc. now we have edited the explore_1 now go To File menu in 
Resource hacker and save it as explorer_1.exe it will ask u that explorer_1.exe is already present do u want to 
replace it, click YES. Now we have our edited explorer. 

• Now restart ur computer in safe mode with command prompt by pressing F8 during booting process . Now we will 
copy explorer_1.exe on explorer.exe by typing command Copy C:\windows\explorer_1.exe 
C:\windows\explorer.exe 

• Now restart ur computer and what u will seeing that u r working with ur edited explorer. If anything goes wrong 
than just copy explorer_2.exe on explorer.exe by same process. 

• 5) Speed Up Detailed View in Explorer  
If you like to view your files in Windows Explorer using the "Details" view here is a tweak to speed up the listing of 
file attributes: 

• Viewing files in Windows Explorer using the "Details" mode shows various attributes associated with each file 
shown. Some of these must be retrieved from the individual files when you click on the directory for viewing. For a 
directory with numerous and relatively large files (such as a folder in which one stores media, eg: *.mp3's, *.avi's 
etc.), Windows Explorer lags as it reads through each one. Here's how to disable viewing of unwanted attributes 
and speed up file browsing: 

• Open Windows Explorer.  
• Navigate to the folder which you wish to optimize.  
• In "Details" mode right-click the bar at the top which displays the names of the attribute columns.  
• Uncheck any that are unwanted/unneeded.  
• Explorer will apply your preferences immediately, and longs lists of unnecessary attributes will not be displayed. 
• Likewise, one may choose to display any information which is regarded as needed, getting more out of Explorer.  
• 6) Remove Hibernation File 
• If you do not use hibernation, make sure you do not have it enabled, which reserves disk space equal to your 

RAM. If you have a hidden file on the root directory of your C-drive called hiberfil.sys, hibernation is enabled. To 
remove that file: 

• Go to Control Panel, select Performance and Maintenance, Power Options, Hibernate tab, and uncheck the Enable 
hibernation box. 

• 7) Change Drive Letters in Windows XP 
• When you add drives to your computer, such as an extra hard drive, a CD drive, or a storage device that 

corresponds to a drive, Windows automatically assigns letters to the drives. However, this assignment might not 
suit your system; for example, you might have mapped a network drive to the same letter that Windows assigns 
to a new drive. When you want to change drive letters, follow these steps:  

• Right-click My Computer, and then click Manage.  
• Under Computer Management, click Disk Management. In the right pane, you’ll see your drives listed. CD-ROM 

drives are listed at the bottom of the pane.  
• Right-click the drive or device you want to change, and then click Change Drive Letter and Paths.  
• Click Change, click Assign the following drive letter, click the drive letter you want to assign, and then click OK. 
• 8) Do Not Highlight Newly Installed Programs 
• Tired of that annoying little window that pops up to tell you that new software is installed? If it gets in the way 

when you’re logging off, turn it off completely. To do this: 
• Click Start, right-click at the top of the Start menu where your name is displayed, and then click Properties.  
• In the Taskbar and Start Menu Properties dialog box, on the Start Menu tab, click Customize.  
• Click the Advanced tab, and then clear the Highlight newly installed programs check box.  
• Click OK, and then click OK again. 
• 9) Change the Default Opening Folder in Windows Explorer  
• By default, Windows Explorer opens showing the My Documents folder. To change the default setting so that all 

top–level drives and folders are shown, follow these steps:  
• Click Start > Programs > Accessories, then right–click Windows Explorer, and click Properties.  
• Under Target field, which reads %SystemRoot%\explorer.exe, add to make the line read: 
• %SystemRoot%\explorer.exe /n, /e, /select, C:\ 
• Click OK. 
• 10) Identify a 16-bit Program 
• Use Windows Explorer to open the folder that contains the program's executable (.exe) file.  
• Right-click the .exe file, and then click Properties.  



• A 16-bit program does not have a Version tab in this dialog box. 
• 11) Use the Desktop Cleanup Wizard in Windows XP 
• To start the Desktop Cleanup Wizard: 
• Click Start , and then click Control Panel.  
• In Control Panel, click Appearance and Themes under Pick a category.  
• Under or pick a Control Panel icon , click Display. The Display Properties dialog box is displayed.  
• In the Display Properties dialog box, click the Desktop tab, and then click Customize Desktop. The Desktop Items 

dialog box is displayed.  
• Under Desktop cleanup , click to clear the Run Desktop Cleanup Wizard every 60 days check box if you do not 

want the Desktop Cleanup Wizard to automatically start every 60 days. 
• Click Clean Desktop Now. The Desktop Cleanup Wizard starts.  
• 12) Remove Unwanted Shortcuts  
• In the Welcome to the Desktop Cleanup Wizard dialog box, click Next.  
• In the Shortcuts dialog box, a list of shortcuts are displayed in the Shortcut to Clean Up list. The shortcuts that you 

click are removed from the desktop and placed in the Unused Desktop Shortcuts folder on the Windows desktop. 
• If you do not want a shortcut to be removed from the desktop, click to clear the check box for that shortcut, and 

then click Next when you are finished. 
• In the Completing the Desktop Cleanup Wizard dialog box, view the items in the Shortcuts box to confirm that you 

want them removed from the desktop, and then click Finish.  
• The Desktop Cleanup Wizard moves the selected shortcuts to the Unused Desktop Shortcuts folder and then quits.  
• 13) Restore Shortcuts 
• If a shortcut that you want is removed, follow these steps to restore the shortcut:  
• On the Desktop, double-click the Unused Desktop Shortcuts folder. The Unused Desktop Shortcuts dialog box is 

displayed. Note: If the Unused Desktop Shortcuts dialog box is maximized, click the Restore Down button (appears 
to the left of the red Close button). 

• Drag the shortcut that you want to the Windows desktop.  
• Close the Unused Desktop Shortcuts dialog box. 
• 14) How to Turn On Automatic Updates 
• Click Start , click Control Panel , and then double-click System.  
• Click the Automatic Updates tab, and then click one of the following options:  
• - Download the updates automatically and notify me when they are ready to be installed. (This is the default 

setting.)  
• - Notify me before downloading any updates and notify me again before installing them on my computer.  
• 15) How to Turn Off Automatic Updates  
• Click Start , click Control Panel , and then double-click System.  
• Click the Automatic Updates tab, and then click Turn off automatic updating. I want to update my computer 

manually.  
• 16) How to Update Your Files Manually by Using Windows Update 
• If you choose not to use automatic updating, you can still install specific updates from the Windows Update Web 

site. Windows Update is a catalog of items such as drivers, security fixes, critical updates, the latest Help files, and 
Internet products that you can download to keep your computer up-to-date.  

• Click Windows Update in Help and Support Center.  
• On the Windows Update home page, click Scan for updates.  
• Click Yes when you are prompted to install any required software or device drivers.  
• 17) How to Have Windows Remind You About Pending Updates  
• Click Remind Me Later in the Automatic Updates dialog box before you download or install the update.  
• In the Reminder dialog box, you can specify the amount of time Windows should wait before reminding you.  
• If the reminder is for downloading, Windows reminds you only when you are connected to the Internet.  
• If the reminder is for installing, Windows reminds you according to the schedule that you specify.  
• 18) How to Download Available Updates 
• If you configured automatic updating to notify you before downloading any updates, an icon is displayed in the 

notification area each time new updates are found.  
• Double-click the icon in the notification area.  
• Do either of the following steps: 
• If you want Windows to download an update, make sure that the check box beside it is selected.-or-  
• If you do not want Windows to download an update, click to clear the check box beside it.  



• Your selected updates are downloaded in the background; this behavior allows you to continue working 
uninterrupted. Downloading does not interfere with or slow down other network activity, such as Internet 
browsing.  

• When downloading is finished, the icon is displayed in the notification area to notify you that updates are ready to 
be installed.  

• 19) How to Pause or Resume Downloading 
• After the download process has started, you can pause or resume downloading at any time. If you close your 

Internet connection or restart your computer after pausing a download process, Windows automatically resumes 
the download process the next time you are connected to the Internet.  

• During the download process, click the icon that is displayed in the notification area, and then click Pause.  
• When you are ready for Windows to start downloading again, click the Automatic updating icon, and then click  
• Resume.  
• Restore an Update that You Previously Declined 
• If you decide not to download a specific update, you can prompt Windows Update to offer that update again.  
• Click Start , click Control Panel, and then double-click System.  
• Click the Automatic Updates tab, and then click Restore Declined Updates. 
• 20) Using the Ultimate Configuration Tool (Professional Edition Only) 
• One of the most full featured Windows XP configuration tools available is hidden right there in your system, but 

most people don't even know it exists. It's called the Local Group Policy Editor, or gpedit for short. It just like old 
Poledit.exe. 

• To start this editor: 
• Select Start and then Run, then type the following:  
• gpedit.msc  
• After you hit Enter, you'll be greeted by gpedit, which lets you modify almost every feature in Windows XP without 

having to go to regedit. 
• 1.Using More Than One Modem at a Time  
• (Win98, WinME and Win2000) 

If you have two phone lines in your home and want to use them both to dial out, 
you can use MultiLink, which will effectively double your connection speed. Create a dial-up connection like your 
normally would.  
Right click on the icon and select Properties  
Click on the Multilink tab  
Click on Use additional devices  
Click on the Add  
Click on the other modem you would like to use  
If your ISP allows, you can use the same phone number, otherwise enter an additional phone number to dial.  
You should now connect with both modems.  
You can confirm this by opening up your dial up connection in the System Tray after you connect. 

• 2.Seeing Servers Your Are Connected To When OnLine 
• To see what servers you are connected to when on the Internet 

Simply run Netstat 
• 3.Backing Up Your ISP Settings 
• If you want to save your ISP settings (name, phone, login id etc.) for future installations: Start Regedit  

Go to HKEY_CURRENT_USER \ RemoteAccess  
Select Registry / Export Registry  
Make sure Selected branch is checked  
For the name, enter any name that will help you remember the purpose of the .reg file  
Now if you need to restore your ISP settings after a new installation of Windows, you just need to import this file  

• 4.Forcing Alpha-Numeric Passwords 
• In order to force passwords that just use alpha-numeric characters Start Regedit  

Go to HKEY_LOCAL_MACHINE \ Software \ Microsoft \ Windows \ CurrentVersion \ Policies \ Network  
Create a DWORD entry called AlphanumPwds  
Give it a value of 1  

• 5.Speeding Up Internet Searches 
• When you go to a web site, the first thing that happens is that a query goes out to the DNS server for IP address 

of the web site. 
In order to eliminate this query, you can simply add the IP address and web name into the HOSTS file in the 
Windows directory. 
To find the IP address, just PING the web name (ping www.microsoft.com) For example, Microsoft would be: 



• 207.46.130.149 www.microsoft.com #.url 
• You can do this for all the sites you regularly visit. 
• 6.Auto-Dial Internet Connections (Win98) 
• If Win98 is not automatically dialing your Internet Connection: Open up the Dial Up Networking box  

Click on Connections / Settings  
Uncheck Prompt for information before dialing. 

• 7.Opening the Make New Connection Dialog Box 
• This command line will pop up the "Make new connection" window. rundll rnaui.dll,RnaWizard /1 
• 8.Help Stop Modem Disconnects 
• If you modem goes offline frequently, it may be due to a temporary lost carrier. To lengthen the time the modem 

will go offline after the carrier is lost, change the modem properties. Open up the Control Panel  
Double click on the Modem icon  
Click on Properties / Connection / Advanced  
In the Extra Settings, enter S10=10  
This will enable the modem to stay connected without a carrier for up to 10 seconds. 

• 9.Speeding Up Your Modem's Dialing 
• For Win95, to make that modem dial much faster: Open up the Control Panel  

Double click on the Modem icon  
Click on Properties / Connection / Advanced  
In the Extra Settings enter S11=x , where x is how many milliseconds each tone sounds. Try S11 = 1, then dial, 
you'll be surprised. 

• 10.Showing Your Actual Modem's Connection Speed 
• Normally when you open up the modem icon in the system try, it shows the port connect speed. 

So see your actual modem speed: Go Control Panel  
Open up the Modems icon  
Click Properties  
Click on the Connection tab  
Click the Advanced button  
In the Extr Settings, put ATW2L0 (the last character is a zero) 

• 11.Increasing Modem Performance 
• To increase modem performance when connecting to the Internet: Disable compression on your modem  

In SYSTEM.INI under 386enh section put in: COMxBUFFER=1024 (x is your modem port number )  
Add AT%C0 (that's a zero),to the extra settings line of your modem's properties.  
Switch errror correction off  

• 12.To Find Your IP Address 
• To find your IP address when connected: Open Explorer  

In the Windows folder find the file WINIPCFG.  
Drag a shortcut onto your screen.  
Now when you are online you can double click the shortcut to see your IP address and other data. 

• 13.Using UNC Network Names with Files 
• As already mentioned, you can use long file names in an MS DOS Box. 

But you can even use UNC-style network names. Example: DIR \\server\share1\dir1 
will give you all files on the computer named "server", in the share named "share1" and in the directory "dir1". 

• This does not work with CD, but it will work with MD, RD, DIR, COPY, MOVE, REN, and so on. 
I use this in combination with a batch file to copy files to a number of computers on a network 

• 14.Changing the Number of Rings Before Dial-Up Server Answers 
• To change the number of rings before Dial up Networking Server answers: Find the INF file for the modem in the 

\WINDOWS\INF directory. The filename will begin with "mdm" and end with characters desciptive of the 
manufacturer, ie. "supra" for Supra Express modem.  
Make a copy of this file.  
Edit this file with notepad and look for a string "HKR, Answer, 1,, "ATA<cr>".  
Change to HKR, Answer, 1,, "None".  
A few lines up from this should be the line HKR, Monitor, 1,, "ATS0=0<cr>" Change the value of the S0 register to 
the number of rings you would like to have the modem answer on.  
Remove the modem by using the Control panel | System | Device Manager.  
Reinstall the modem using the REFRESH Button.  
This should install the modem using the updated INF file. 

• 15.Resetting Forgotten Dial-Up Server Password 



• If you forget the password you set for you Dial-Up Server 
simply delete (or rename) the RNA.PWL file in the WINDOWS directory 

• 16.Monitoring Your Dial-Up Connection 
• There are some system checks you can use to see how good your ISP and Phone lines are. 

You either net OEM SR2 or the ISDN Accelerator Pack 1.1 installed Make sure SYSMON is installed. You can add 
this through the Control Panel / Add New Programs  
Run SYSMON  
Select Edit / Add Item  
Click on Dial-Up Networking Adapter  
Select CRC Errors  
Click on OK  
If you have lots of CRC errors, either the phone lines or your modem is having problems. 

• You can also add Framing Errors and Timeout Errors if you are still having problems and your 
• 17.Fixing a problem with Shortcuts that keep network UNC connections 
• By default, when you create a shortcut to a network application, both the Drive letter and UNC connection are 

stored as part of the shortcut. 
The reasoning that if the drive letter gets reassigned or deleted, the UNC connection will serve as an additional 
way to ensure that the application is available. 
This can also be a problem because when you want to re-assign the drive to a new server, it will still make the 
connection to the old one through the UNC To disable this feature, there is a program called SHORTCUT.EXE in 
the Admin / Apptools / Envvars directory. 
Execute the program with a -? to see a description of the available switches. 

• 18.Starting a Dial-Up Connection from the Command Line 
• You can dial your ISP from a command line. This can make it easy to create a batch file that will 

do things like dial, start your e-mail and web browser. The syntax is: 
rundll rnaui.dll,RnaDial connectoid 

• Note: The RnaDial and connectoid components of the command line are case sensitive 
• 19.Device Contention when trying to use a Modem 
• Occasionally, when trying to use your modem, you might get the following errors: Another program is using the 

selected Telephony device. Try again after the other program completes. 
or 
Cannot initialize port 

• The state of Windows 95 device contention is determined by the value for the "COM n AutoAssign=x" 
setting in the [386Enh] section of the System.ini file, 
where n is the number of the serial port and x is a value from -1 to 1000. 

• The default setting in Windows 95 is -1. This setting causes Windows 95 to not release a serial port previously 
used 
by a non-Windows-based program. 

• If you need hot-swapping capability between an MS-DOS-based communications program and a Windows-based 
communication program, 
add the following entry to the [386Enh] section of the System.ini file: 

• Com n AutoAssign=0  
• 20.Unable to Browse the Network 
• If you do not have a logon password, Windows95 might have problems when you try and browse the network. 

Try the following steps to solve the problem. Start REGEDIT  
Go to Hkey_Local_Machine \ Software \ Microsoft \ Windows \ Current_version \ Network \ Real mode net  
Delete the line that says AUTOLOGON=0  
Save the changes and reboot the system  

• 21.Auto-Dialing for 32-bit Internet Applications 
• If your 32-bit Internet applications do not automatically invoke your 

Windows 95 Dialer, here is a way I found to enable this feature. First, bring up an internet application such as 
Netscape or Internet Explorer.  
Next, manually dial into your internet provider by double-clicking your connection icon.  
Once connected, go to the Control Panel and double-click on the Internet icon.  
Once the window open, uncheck the checkbox titled "Dial whenever an Internet Connection is needed".  
Click the check box again and make sure there is a check in the checkbox.  
Next, click the APPLY button.  
Finally , click the OK button.  
Once you do this, close your internet application and disconnect from your internet provider. 
Re-start your Internet application and the Windows 95 dialer should start up. 



NOTE: From my experience, all Internet applications will be effected and will automatically start the Windows 95 
dialer.  

• 22.Changing your Modem's Initialization String 
• Start REGEDIT  

Go to HKEY_LOCAL_MACHINE \ System \ CurrentControlSet \ Services \ Class \ Modem \ 0000 \ Init  
Change the settings to the values for your modem 

• 23.Increasing the Modem Timeout 
• If your modem it timing out during file transfers or loading Web Pages, 

you might try increasing the timeout period. To change it: 
• Start Regedit  

Go to HKEY_LOCAL_MACHINE / System / CurrentControlSet / Services / Class / Modem / XXXX / Settings 
Where XXXX is the number of your modem  
Move to the right panel and double click on Inactivity Timeout  
The number of minutes for a timeout should be entered between the brackets.  
For example, a US Robotics Sportster could have S19=<30> to set it to 30 minutes. 

• 24.Potential problems leaving 16-bit winsock.dll's 
• If you re having problems getting some of your winsock applications 

to work under Win95, make sure you delete any old 16-bit winsock.dll's. If this file is in the directory were the 
application resides, it could 
cause problems. Programs that could have problems like this are: 

• Ewan.exe (Telnet app)  
WSIRC.exe (IRC app)  
WSGopher.exe (Gopher app)  
NX.Exe (NewsXpress)  
Netscape v.1.0  
We found that if the software listed above is in the same directory as the 
Trumpet Winsock.dll file, then they will NOT work under the MS-TCP/IP stack. 

• 1.Creating a New E-Mail Shortcut 
• To create a shortcut that will open your default e-mail program starting a new e-mail, Right click on an open area 

of the desktop  
Select New / Shortcut  
For the Command Line, enter mailto:  
For the title enter something like New E-Mail  
When you click on this your default e-mail program should start with a new e-mail form. 

• 2.Creating 3D Window Effect 
• You can create a nice 3D effect for your windows Start Regedit  

Go to HKEY_CURRENT_USER \ Control Panel \ Colors  
Make sure the following setting are there:  
ButtonHilight=128 128 128  
ButtonShadow=255 255 255  

• 3.Creating Shutdown, Restart and Logoff Icons 
• To create the icons, create a shortcut on the desktop. For Shutdown, the command is C:\WINDOWS\RUNDLL.EXE 

user.exe,exitwindows 
• For Restart, the command is C:\WINDOWS\RUNDLL.EXE user.exe,exitwindowsexec 
• For Logoff, the command is C:\WINDOWS\RUNDLL.EXE shell32.dll,SHExitWindowsEx 0 
• 4.Having your Favorites and Start Menus Sort Alphabetically 
• If your Start Menu Program or Favorites are not sorting alphabetically, it is easy to fix this: Start Regedit  

Go to HKEY_CURRENT_USER/Software/Microsoft/Windows/CurrentVersion/Explorer/MenuOrder  
Under here is are Favorites and Start Menu folders  
In each there is a value called Order  
Simply delete (or rename this) and restart Winodws  
Your Favorites or Start Menus should now sort alphabetically  

• 5.Increasing the Icon Cache 
• Run Regedit  

Go to HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\explorer  
Create a new string called Max Cached Icons  
Give it a value of 10000  
This will increase response time in windows and give the Shellicon cache file more elbow room 

• 6.Make Icons 256 Color 16-Bit 



• Open the Registry  
Hit Ctrl+F  
Type Shell Icon BPP  
When found, right click the Shell Icon BPP icon  
Click Modify  
Change the value from 4 to 16  
Click Ok  
Close the registry  
Restart your computer  

• 7.Removing Shortcut Arrows 
• An easy way to remove those irritating arrows from your desktop shortcut icons and not change their properties 

Right click the Desktop / Properties / Appearance tab  
Select Item  
Scroll for Icon  
The default size is 32  
Change this to 30  
Clicking Apply  

• 8.Adding the Control Panel to the Start Menu 
• Open up the Explorer  

Go to \WINDOWS\Start Menu  
Right click in the right-hand panel  
Add a new folder  
Name it Control Panel.{21ec2020-3aea-1069-a2dd-08002b30309d}  
This makes getting to the Control Panel items a little easier  

• 9.Making Desktop Changes Permanent 
• To make changes to the Desktop like window size, positon after rebooting: Start Regedit  

Go to HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer  
Create a New Binary Value  
Name it NoSaveSettings  
Give it a value of 01 00 00 00  

• 10.Changing a Folder's Icon 
• To change the icon of a Folder on desktop: Using the Explorer, move the folder from the Desktop directory to 

another directory on the hard drive  
Right click on the new folder and select "Create Shortcut"  
Move the shortcut to the Desktop  
Right click and select a new icon  

• 11.Full Window Drag ( Without Plus! ) 
• Start Regedit  

Open HKEY_CURRENT_USER /ControlPanel /Desktop /DragFullWindows  
On "DragFullWindows" properties change 0 to 1  

• 12.Getting Screen Shots 
• If you need to get a screen shot, and you do not have a screen capture program, try this: Hit the Print Screen key. 

This copies a bitmap of the full screen into the Windows clipboard. Start up a graphics editor and paste it in.  
Alt + Print Screen will capture only the active window.  

• 13.Increasing the Size of the Scroll Bar 
• How to adjust the width of the scroll bar: 
• Select Properties  

Select the Appearance tab  
Go to the item list and find scrollbar.  
Increasing the value in the Size field will increase the scrollbar width. 

• 14.Customizing Individual Folder Icons 
• To change a folder's icon: Open Notepad and enter two lines,  

[.ShellClassInfo] 
IconFile=file name,number 
(e.g. IconFile=C:\Icon\CustomFolder.ico,0)  

• Save the file as DESKTOP.INI in the folder you wish to change.  
Click Start -> Run, type in the command line, 
ATTRIB +S "folder name" 
(e.g. ATTRIB +S "C:\Custom Folder")  



Open Explorer or My Computer and refresh (press F5 key).  
This tip only work Windows 95/NT 4.0 + IE 4.0 with shell integration, or Windows 98/NT 5.0. 

• 15.Removing the Recycle Bin 
• To remove Recycle Bin from the desktop: Run REGEDIT.  

Find NAMESPACE key in left pane (HKEY_Local_Macine \ Software \ Microsoft \ Windows \ Current Version \ 
Explorer \ Desktop \ Namespace)  
Expand NAMESPACE (click '+' box)  
Delete the value RECYCLE BIN in right pane 

• 16.Adding Send To the Recycle Bin 
• Add a SHORTCUT TO THE RECYCLE BIN in your SEND TO folder. That way you can just right click on a file you 

want to delete, and send it to the recycle bin without having to confirm each time. 
• 17.Having Icons with No Name 
• Normally you have to have a name for an icon, just spaces are not allowed. 

To create an icon with no name attached: Make sure NumLock is on  
Highlight the Icon you want to change  
Right-Mouse click and select Rename  
While holding down the Alt key, type 0160  
Now the icon will have no name below it.  
To Create Multiple Icons with No Name - From John R. 

• Follow directions detailed above  
With the second icon simply add one space-bar character AFTER the 0160 number.  
Each successive icon gets an additional space-bar character at the end (to prevent a duplicate naming error). 

• 18.Moving the Start Button 
• How to move or close the start button! Click on the Start button  

Press the Esc key  
Press the Alt and the - keys together  
This will give you a menu, you can move or close  
But if you move it you need to use the arrow keys and not the mouse. 

• 19.Aligning Drop-Down Menus to the Right 
• All dropdown menus can be aligned to the right. 

This features becomes useful when trying to access 
menus with submenus that appear directly to the right.  
Open the Registory editor (e.g. regedit.exe)  
Goto \\HKEY_CURRENT_USER\Control Panel\Desktop  
Create a string entry called "MenuDropAlignment"  
Set its value to 1  
Reboot  
Note: Will not work under NT 4.0. 

• 20.Changing Drive Icons 
• To change a drive's icon when you open My Computer Create a file called AUTORUN.INF on the root of your hard 

drive  
Enter the lines  
[autorun] 
ICON=Name of the ICON file 

• For the name of the icon file you can either specify the path and name (e.g. 
ICON=C:\WINDOWS\ICONS\MY_ICON.ICO) or 
a specific icon in a library (e.g. ICON=ICONFILE.DLL,2 

• 21.Adding Shortcuts to Desktop Without "Shortcut To" text 
• Start Regedit  

Go to:HKEY_USERS \ .Default \ Software \ Microsoft \ Windows \ CurrentVersion \ Explorer  
Add binary value to Explorer:link="00,00,00,00"  
Now You can make Shortcuts to desktop without Shortcut To" text. 

• 22.Changing the clock to 24-Hour Time 
• To change the display of the clock on the taskbar to 24-hour format:  

Open the Control Panel  
Double-click on the Regional Settings icon  
Click on the Time tab  
In the Time style section select H:mm:ss  

• 23.Changing or Removing the Start Menu Icons 



• Download Microangelo and install it.  
Create a blank.ico file.  
Put it in a directory (C:\Windows. Then double click on the Microangelo Engineer to run it.  
When you get it up on the screen click on the "start" tab. You will see a list of all the icons in the start menu.  
Highlight the first one (programs) and select "Change". It will bring up a dialog box - select "browse".  
Go to the directory that contains the blank icon and select it. Hit OK until you get back to the main  
Engineer window and do all the rest exactly the same way.  
When you have finished changing them all to the blank icon, Hit "Apply".  
Hit your start button and look to see if all the icons are invisible. (They should be.)  
Close out Micro Engineer and you're finished.  

• 24.Adding Drive to the SendTo List 
• I have recently found that if you want to send something from A: drive or from any where to any drive, you can 

just make a short cut of that drive in subdirectory SENDTO.  
For example I have two hard drives, a Floppy Drive, and a CDROM  
After I have make a copy of each of my drive I will be able to send a whole directory of E:\XXX from the CDROM 
drive to A: drive or any other drive that i have had made the short c t in the SENDTO subdir of WINDOWS.  

• 25.Customizing the Start Button's Name and Icon 
• To change the name of the Start button: Copy EXPLORER.EXE in your Windows directory to another directory  

Start a hex editor (I've been using Diskedit from Norton)  
Edit EXPLORER.EXE  
Search for the string 53 00 74 00 61 00 72 00 74  
This is the word Start with the letters separated by a null character  
The section you are in should also have the words "There was an internal error..." also separated with the null 
character immediately following  
Now just replace the Start letters with any of your choice (up to 5 characters only)  
Exit Windows  
Boot to DOS  
Copy your new Explorer file over the original  
To change the Start button icon: 

• Copy USER.EXE in your \WINDOWS\SYSTEM directory to another directory  
Use an icon editor that can replace icons in executable files  
Edit USER.EXE and replace the flag icons with the icon of your choice  
Boot to DOS  
Copy the new USER.EXE  
The same can be done with NT 4.0, just the offset will be different but the location to just before "There was an 
internal error..." is the same. 

• 26.Create a Control Panel menu directly below the Start Button 
• Click the Start Button once with your right mouse button. You should see a right-button menu (called a context 

menu because it offers different choices in different contexts).  
You should see the items Open, Explore, and Find on the context menu. Click Explore with your left mouse button.  
An Explorer file management window should open. A directory tree should appear in the left pane, with the right 
pane displaying the contents of the Start Menu folder.  
Right-click any empty space within the right pane. A context menu should appear. Click New and then Folder.  
The Explorer will create a highlighted icon called New Folder. Type in the following string, all on one line, replacing 
the words New Folder with this new line. You must type the period, the curly braces, all four hyphens, and the 
hexadecimal numbers exactly as shown. After the closing curly brace, press Enter.  
Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D} 
Other Folders can be added following the same instructions. Dial-Up Networking.{992CFFA0-F557-101A-88EC-
00DD010CCC48}  
Printers.{2227A280-3AEA-1069-A2DE-08002B30309D}  
Inbox.{208D2C60-3AEA-1069-A2D7-08002B30309D}  
My Computer.{20D04FE0-3AEA-1069-A2D8-08002B30309D}  
Recycle Bin.{645FF040-5081-101B-9F08-00AA002F954E}  
Network Neighborhood.{208D2C60-3AEA-1069-A2D7-08002B30309D}  
Desktop.{00021400-0000-0000-C000-000000000046}  
Briefcase.{85BBD920-42A0-1069-A2E4-08002B30309D}  
Fonts.{BD84B380-8CA2-1069-AB1D-08000948F534}  

• 27.Turn Off Window Animation 
• You can shut off the animation displayed when you minimize and maximize windows. 

This tip makes navigating Windows 95 a lot faster especially for those that don't have 
super fast video cards. Open Regedit  



HKEY_CURRENT_USER  
Control panel  
Desktop  
WindowMetrics  
Right Mouse Click an empty space in the right pane.  
Select new/string value.  
Name the new value MinAnimate.  
Doubleclick on the new string value (MinAnimate) and click on "Modify"  
Enter a value of 0 for Off or 1 for On then hit  
Close Regedit and all programs then reboot. 

• 28.To speed up the Start Menu 
• Start the REGEDIT program  

Search for the word desktop  
This should be in HKEY_CLASSES_ROOT / CLSID / {00021400...  
Right Click on the right panel  
Pick NEW / String Value.  
Name it MenuShowDelay, all one word.  
Select a value from 1-10, 1 being the fastest.  
Exit REGEDIT  
Restart Windows  

• 29.To change the Startup and Logoff screens 
• Startup Screen 

Create a 320x400 bitmap in the root directory and name it LOGO.SYS  
You can use LOGOW.SYS file in the Windows directory as a starter  
Logoff Screens 
There are several files called LOGOX.SYS  
They are actually bitmaps 320x400 that just have a different extension  
The hidden one in the root directory LOGO.SYS is the startup logo.  
There are two files in the Windows directory.  
LOGOW.SYS is the Wait while Shutting down ... screen  
LOGOS.SYS is the You may now shut-off or Reboot screen  
To edit them, rename them with a BMP extension and use your favorite graphic editor  
You can edit these files or create you own  
They just need to be the same size  

• 1.Using the Explorer's SEND TO Feature 
• When you right click on a file, SEND TO is one of the options.  

To add other directories or programs, simply drag them to the SEND TO folder that is directly under the directory 
where you installed Win95.  
This will allow you to quickly move files to commonly used areas.  
For example, you can SEND TO applications like WinZip. 

• 2.Starting the Explorer from the Current DOS Directory 
• To start Explorer from whatever subdirectory you are in when shelled out in DOS: Type "Start .\"  

The Explorer will start in that very same directory  
"Start ..\" will start the Explorer one directory above the current one.  
"Start \" will start the Explorer at the root of the drive. 

• 3.Explorer Shortcut Keys 
• F4 - Displays the Combo Box  

F5 - Refresh the display  
Ctrl+G - Go to a specific directory  
Ctrl+Z - Undo last action  
Backspace - Go up one directory  

• 4.Starting Explorer when opening a Folder 
• To have an Explorer window be the default when you open up a Folder: Open up any folder.  

Select View / Options  
Select File Types  
Go down to Folder  
Click on Edit  
Highlight Explore  
Click on Set Default  
Click on Close  
Click on Close again  



Now when you open a folder, you will get an Explorer window with the programs or shortcuts in the right panel 
and the regular explorer window in the left panel.  

• 5.Expanding All Subfolders in Explorer 
• To quickly have Explorer expand all subfolders for a selected drive or folder, 

simply press the asterisk (*) key on the numeric keypad 
• 6.Easier File Copying with Explorer 
• One difference between Explorer and File Manager is that with File Manager 

you could open up two windows to more easily copy files between drives. 
To do the same thing with Explorer: Close all running applications  
Start two copies of Explorer  
Press Ctrl-Esc to bring up the task bar  
Right click on an open space  
Select Tile Horizontally or Vertically depending on your preference  
Your two Explorer sessions will now split the screen and you can copy between them by 
dragging files like before. 

• 7.Starting Explorer with No Drives Expanded 
• Normally when you start the Explorer, it expands the folders on the root of the C: Drive. 

For those computers with multiple hard drives plus CD ROM Drives, this might not always be what you want. 
If you want it to start without expanding any drives, use the following switches: EXPLORER /n, /e, /select, c:\ 

• This will work with NT 4.0 as well  
• 8.Opening a DOS Prompt in the Directory You Want 
• You can use the Explorer to easily open up a DOS window to a specific directory. From Explorer Option Menu 

select File Types  
Highlight the object for Folder - NOT File Folder  
Click the Edit button  
From the 'Edit File Type' panel click the 'New' button  
Action is '&Goto DOS Prompt'  
Application used is C:\windows\command.com /k cd %1  
Select OK, then Close and Close.  
Now from Explorer secondary (right) click the folder you want to go to in DOS  
From the menu select 'GotDOS Prompt' (or hit G) and you are in that directory with a DOS windows  
For Win NT 4.0 same tip, but substitute cmd.exe for command.com)  

• 9.Added Non-Expanded Explorer when Right Clicking on a Folder 
• Adding a second Explorer to the menu that pops up when right clicking on any folder or the Start Button. 

This is handy to be able to open Explorer non-expanded and also for being able to open a second Explorer (non-
expanded) while already in Explorer. Open My Computer  
Choose View-Options-File Types  
Select the File Folder file type  
Click Edit  
For ACTION, type EXPLORER2  
For APPLICATION USED, type C:\WINDOWS\EXPLORER.EXE /n,/e,/select,C:\  
Click OK and close all windows  
Run REGEDIT  
Expand HKEY_CLASSES_ROOT  
Locate and expand DIRECTORY  
Locate and expand SHELL  
Locate and expand EXPLORER2  
Select COMMAND  
On the right window RIGHT CLICK on DEFAULT  
Select MODIFY  
Remove the space and %1 at the end of the line  
Click OK and close REGEDIT  
EXPLORER2 will show up and launch a non-expanded view of Explorer whenever you right-click on the START 
BUTTON or any folder, even if you are already in Explorer. 

• The whole procedure can be done in REGEDIT, but this may be safer for users not experienced with REGEDIT  
• 10.Automatically Adjusting Right-Panel Column Widths 
• The column widths in the right hand panel of the Explorer might not be the correct sizes to display all the file 

information. 
To automatically adjust all the columns at once to show all the information, Click somewhere on the right-hand 
panel  
Simply press the Ctrl-+ key.  



The Name, Size, Type and Modified columns will automatically adjust themselves to display all their information.  
Note: The + is the one on the numeric keyboard  

• 11.Hiding the File Menu in the Explorer 
• To hide the File Menu in Explorer: Start Regedit  

Go to HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer  
Create a new Binary Value  
Name it NoFileMenu  
Give it a value of 01 00 00 00  
Reboot the computer  

• 12.Changing the Explorer's Web View Background 
• If you use Web View for your Explorer, you can change the background that appears. Edit or recreate the file 

>C:\Windows\Web\Wvleft.bmp 
• Make sure you keep the file dimensions the same 182x237 pixels 
• 13.Keeping Filenames in the Case You Want 
• To stop Windows from changing the case of your filenames to upper or lower case: Start Regedit  

Go to HKEY_CURRENT_USER \ SOFTWARE \ Microsoft \ Windows \ CurrentVersion \ Explorer \ Advanced  
Double-click DontPrettyPath (or create this key with a type of REG_DWORD if it doesn't exist)  
Set the value to 1 to keep the case as you type it or 0 to adjust the case as Explorer requires  
Click OK  
Close Regedit  

• 14.Resetting Graphics PreView in Explorer 
• For Windows98, ME or Windows 2000, if you have View as Web Page enabled but do not see a picture preview in 

Explorer: Start Regedit  
• Go to Registry key: HKEY_CLASSES_ROOT \ file type \ ShellEx \ {BB2E617C-0920-11d1-9A0B-00C04FC2D6C1}  

Make sure the Default Value "{7376D660-C583-11d0-A3A5-00C04FD706EC}" 
• 15.Changing Drive Labels in Explorer (Windows2000 and XP) 
• Normally the Explorer shows drive labels as "Compact Disk", "Removable Disk" ect. To change the name of this 

label for specific drives: 
• Start Regedit  

Go to HKEY_LOCAL_MACHINE / SOFTWARE / Microsoft / Windows / CurrentVersion / Explorer  
Create a key called DriveIcons  
Within DriveIcons, create another key with the drive letter you want to change (..\DriveIcons\K)  
Create another within the drive letter key called DefaultLabel  
Give the Default Value for this key the label you want to appear for that drive letter. (Jazz Drive etc.)  
Restart the computer  

• 16.Changing Drive Icons in Explorer 
• To change the icon used for specific drives in Explorer Start Regedit  

Go to HKEY_LOCAL_MACHINE / SOFTWARE / Microsoft / Windows / CurrentVersion / Explorer  
Create a key called DriveIcons  
Within DriveIcons, create another key with the drive letter you want to change (..\DriveIcons\K)  
Create another key within the drive letter key called DefaultIcon  
Set the default value equal to the icon you want to use.  
If you have a file that has more than one icon in it, such as a DLL file, use the standard C:\full_path\icon_file.dll,x 
where x is the number of the icon within the file icon_file.dll. 

• 17.Changing the Default Sound in Explorer 
• You can change the default sound heard when navigating to folders in the Explorer. Start Regedit  

Go to HKEY_CURRENT_USER \ AppEvents \ Schemes \ Apps\ Explorer \ Navigating\ .current  
Change the default value to the wav file you want to use.  
Leaving it blank will turn off the sound.  
This also changes the default sound when opening a page in the Internet Explorer. 

• 18.Removing Right-Click Items 
• When you right click on a folder or file with the Explorer, a list of options is available.  

As more applications get installed, this list may get too large for you. To remove items from the list: 
• Note the text of the item you want to remove  
• Start Regedit  
• Go to the following sections in the Registry and delete the subkey with the string you noted in Step 1.  
• HKEY_CLASSES_ROOT\Folder\shell 

HKEY_CLASSES_ROOT\file 
HKEY_CLASSES_ROOT\Directory\shell 



 


